
Eyecare Advantage
Version 11.0.7.0 And 11.0.7.1 Enhancements (9/26/2016)

Take Course Now! Click to watch a video of these enhancements in Compulink University. 
You’ll need the Username and Password associated with your student account to log in.
Ask your manager or Compulink Administrator if you don’t have this information. 

Items marked (Client Request) were requested by clients, and satisfied with this update.

Companion Courses Associated with this Version
(If viewing in a PDF viewer, click the link below the course to go directly to Compulink University

LMS. If viewing in a browser, highlight the entire link, right click and Open Link in New Tab.)

ABB Concise For Contact Lenses (Course ID:INV_305_OZ)
     http://prosperitylms3.com/req/compulink/_student/indexcrs.cfm?crsid=INV_305_OZ

AdvantageERx: E-Prescribe Commands (Course ID:ADERX_115)
     http://prosperitylms3.com/req/compulink/_student/indexcrs.cfm?crsid=ADERX_115

AdvantageERx: EPCS - Controlled Substances (Course ID:ADERX_125)
     http://prosperitylms3.com/req/compulink/_student/indexcrs.cfm?crsid=ADERX_125

AdvantageERx: General Overview (Course ID:ADERX_100)
     http://prosperitylms3.com/req/compulink/_student/indexcrs.cfm?crsid=ADERX_100

AdvantageERx: IdenTrust Registration (Course ID:ADERX_110)
     http://prosperitylms3.com/req/compulink/_student/indexcrs.cfm?crsid=ADERX_110

AdvantageERx: Prescribing A Standard Medication (Course ID:ADERX_120)
     http://prosperitylms3.com/req/compulink/_student/indexcrs.cfm?crsid=ADERX_120

AdvantageERx: Refilling A Medication (Course ID:ADERX_130)
     http://prosperitylms3.com/req/compulink/_student/indexcrs.cfm?crsid=ADERX_130

AdvantageERx: Setup (Course ID:ADERX_105)
     http://prosperitylms3.com/req/compulink/_student/indexcrs.cfm?crsid=ADERX_105

Compulink Forum (Course ID:CF_105)
     http://prosperitylms3.com/req/compulink/_student/indexcrs.cfm?crsid=CF_105

Customer Feedback (Course ID:CF_100)
     http://prosperitylms3.com/req/compulink/_student/indexcrs.cfm?crsid=CF_100

HOT TOPICS
ICD-10 > End of ICD-10 Grace Period
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HOT TOPICS
• October 1, 2016, Providers will be required to accurately code the highest level of specification
based on clinical documentation, as per the required coding guidelines. 
• Remember to avoid unspecified ICD-10 codes whenever documentation supports a more 
detailed code. 
• To ensure proper coding, audit claims to make sure the coding aligns with the clinical 
documentation. 
• All levels of granularity are already included in your Advantage software. 
• A complete list of the 2016 ICD-10-CM valid codes and code titles is posted on the CMS 
website.

ICD-10 > ICD-10 2017

• Starting October 1st 2016, an updated set of the existing ICD-10 codes will become the 
standard.
• While the vast majority of codes are completely unaffected, there are nearly 2000 codes 
added. 
• In addition, there are about 311 codes that are being discontinued and 425 codes that have 
been revised (in most cases, this is to improve the diagnosis description).
• These codes are delivered in Advantage Versions 11.0.7.1 and greater.

ICD-10 > Stand Alone ICD-10 2017 Table Download

• Clients who are unable to update to Version 11.0.7.1 on or before 10/01/2016, may download
the Diagnosis tables separately in zip file format. 
• Note that this download will affect Compulink-owned Diagnosis table records only. 
• This is a zip file approximately 8MB in size. 
• It extracts to an \UPDATE folder in your Advantage product directory. 
• If during the extraction you are asked to overwrite any files, select NO. If done correctly the 
files will appear inside your UPDATE folder without any warning.
• The next launch of the software will update your codes. This should take 5 minutes or less.
• Important: If you choose to download the ICD-10 table updates separately into an older 
version of Advantage, do so as close to 10/01/2016 as possible. Version 11.0.7.1 is 
programmed to allow the deleted codes to be used through 09/30/2016. Previous versions may 
not recognize that the discontinued date is in the future, preventing them from being used.

General Enhancements
Compulink Advantage Forum > Forum

• The Compulink Advantage Forum provides Information on new and existing functionality, an 
opportunity to network with other clients, resources and tips for efficiency and early release of 
product information prior to publication to other sources. 
• It is staffed by Compulink technical and product manager experts to ensure you have the 
information needed for operational efficiency.
• Monthly Reminder.
          • If you are an owner or manager, and you are not already signed up for the Forum, you 
will receive a monthly reminder upon logging into the software.
          • Click No to close the window, or click Yes to access the Forum now.
• To access the Forum at any other time, click the Help menu and select Forum/User Group.
• For detailed information on the Forum, see the Compulink University LMS course: Compulink 
Advantage Forum.

Customer Feedback > Feedback Options

• Service satisfaction Survey.
          • A new Customer Care Satisfaction Feedback was created.
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General Enhancements
          • These Surveys will only be sent out after the ticket has been resolved. This may be on 
the initial call, or in a follow-up phone call.
          • They will also be sent out for open projects on a weekly basis.

• Anomaly/Request Status Report.
          • A new report was created to show you the following:
          • The status of Anomalies in the Advantage software that your account is attached to.
          • The status of Requests you have submitted to Compulink.

• Anomaly/Request Notification.
          • If an Anomaly or a Request has recently been Resolved/Satisfied, the staff member 
that originally reported it will receive a PopUp upon logging into the Advantage software.
          • These notifications are downloaded when the Anomaly Request Status is checked, with 
each version update you download and/or every 30 days.

• For detailed information on the above items, see the Compulink University LMS Course: 
Customer Feedback.

Reminder Upon Login > Quarterly System Performance Check-In

• One time per quarter when an Owner or Manager logs into the software, they will receive a 
Quarterly System Performance Check-In window.
• If you are experiencing any unusual delays when navigating within the application or slow 
overall performance, you may request a consult with our IT department and your local IT 
company/individual.
• Clicking No on the message will take you into the software as usual.
• Clicking Yes on the message will open a Customer Care Question for the IT Department. In 
the message area, enter the System Performance Issues that you are having and then click 
Submit. A Compulink representative will contact you to schedule an appointment.

Inventory Enhancements
Frames > Sales

• The Sales History window was expanded so you no longer have to scroll left and right to see 
all of the information. (Client Request)

Login ID > Location Restriction

• If the Login ID is restricted to a specific Location, that user will NOT be allowed to add 
Inventory for other Locations.

Function Enhancements
Account Statements > Accts w/Pending Ins flag

• ‘Accts w/Pending Ins’ flag was changed to ‘Skip Accts w/Pending Ins.’
          • If UNCHECKED, it will generate statements for all patients with a responsible balance, 
including those where a portion of the balance is expected from insurance.
          • When CHECKED, the Statement Function will skip ALL patients that have ANY insurance
pending balance.
          • The default is UNCHECKED.

Insurance Activities > Billing > EMC Claim File output for ILOUPAT

• Flat file submitters must use the ID-10 Version Qualifier of ‘0’ (zero) for date of service 
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Function Enhancements
greater than 9/30/2015. (Client Request)
• If the date of service is 9/30/2015 and prior, then it needs to be submitted with a 9 Qualifier.
• The programming for the claim file has now been updated to recognize the dates of service 
and include the correct Qualifier.

Insurance Activities > Billing > National Drug Code (NDC) Information

• The CMS1500 form has been updated to now include the NDC, unit type and number of units 
in the shaded upper area of box 24A.

EDI (Electronic Billing) Enhancements
Direct Billing > Direct Billing 277 Report

• The Message section was expanded to include the explanations for the CSCC (Claim Status 
Category Code), CSC (Claim Status Code) and the EIC (Entity Identifier) codes that are found 
under the REMARK Codes column. (Client Request)

Emdeon > Change Healthcare, formerly known as Emdeon

• All communications between the Advantage software and Change Healthcare (formerly 
Emdeon) have been changed to connect to their new URLs (web addresses), and include 
stronger encryption for your Claims/Remittance/Eligibility transactions. 
• These changes are transparent to you—there is nothing you need to do differently. 
• Change Healthcare has announced a sunset date of 11/1/16 on use of their old URLs.
• Once you upgrade to Version 11.0.7.0 or higher, you will be all set for this.
• Act today to avoid interruption of your cash flow! Those who do not upgrade by the 11/1/16 
sunset date will no longer be able to do electronic billing with Change Healthcare.
• Note: If you have URL restrictions set up in your system, it is very important to allow the 
following URL below to be able to submit claims electronically to ChangeHealthcare/Emdeon. If 
not sure, please contact your IT person. The new URL is its.changehealthcare.com

Report Enhancements
Appointment > Daily > No Future Appt

• You now have the option to run the report for the following options:
          • Filter by the Provider ID on the patient demographic screen.
          • Order the list by either the Account Number or the Provider.
• Patients will qualify for the report if they are Active and do NOT have an appointment 
scheduled in the future, or if they had an appointment scheduled, and it was filtered off based 
upon the Status Code filter established in the System Setup.

Financial > Acct Management > PQR Compliance 2016

• The following codes were added to be included for Measure 117: 92002, 92004, 92012 and 
92014. (Client Request)

Financial > Analysis > Prod. Analysis by Day

• This report has been updated so it now runs faster. 
• The first page now contains the Data Source and Report Definitions. 
• It breaks out the Refunds so the Net Charge and Net Credit definitions are the same as what 
you will see on the Office Production Report. 
• The charts were updated to better handle multiple days, and are more readable.

General Ledger > All Report Windows

Compulink Business Systems, Inc | 1100 Business Center Circle | Thousand Oaks, CA 91320 | 800.888.8075 .
support@compulinkadvantage.com | www.compulinkadvantage.com           4



Report Enhancements

• When running these reports, you will no longer see the list of items scrolling in the window. 
• The functionality is still the same, however, this will greatly increase the speed in which these 
reports will run.

General Ledger > Gl/AP/AR Export Report

• You now have the option of viewing and changing the Threshold Update date. (Client Request)
• The Threshold date now displays below the Output field.
• To change the date, click on Options > Threshold Update. Enter the date and click OK.
• This will update the date both on the screen, and in the System Setup under the AP/GL tab.
• NOTE: If you give your staff access to run this report, this means that they would have the 
option of changing that Threshold Date, which WILL change it under the AP/GL tab, even if they
usually DO NOT have access to the System Setup.

Data Mining Enhancements
Data Mining > Birthday Queries

• All of the Compulink Owned Birthday queries were updated to exclude all inactive patients 
(Active field must be checked). (Client Request)

InBox Enhancements
InBox > Credit Card Integration Message

• If you are not utilizing XCharge, the integrated credit card processing in the Advantage 
Software, and you are posting credit card payments, you will receive a reminder message in 
your Advantage InBox. 
          • This message will only be sent to staff whose Login IDs are set up as Owner and/or 
Manager.
          • Staff may click the message to open the web page to display further information.

InBox > Deleting Faxes

• When a fax is received by the office, it will go into the InBox of all staff that have the login 
right of ‘Receive Incoming Fax’ set to True.
• If one of these staff members DELETES the fax from their InBox, it WILL delete it from ALL 
other InBoxes.

InBox > EDI Utilization Report

• The EDI Utilization Report will automatically run and be sent to the InBox every 30 days for 
staff members that are set up as Owners in the Login IDs table.
• If you are not fully utilizing the automated remittance posting (ERA) and eligibility features of 
your Advantage software, you could be.
• This report has been prepared especially for your practice to help you determine which Payors 
you currently bill that offer ERA and/or eligibility options that you are not using.
• Simply adding these options could not only save you hours of staff time, but also get you paid 
faster and improve cash flow.

InBox > New Message Notification

• If there are new messages in your InBox that have not yet been viewed, a new red indicator 
circle will display on the InBox icon. (Client Request)
• After the items have been viewed, the indicator will disappear once the active screen is 
refreshed or closed.
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Help Enhancements
Help Command > Help Command Expanded to A Menu

• The Help command has been expanded to a menu with multiple options.

• Compulink University/Learn
          • This was previously the ‘Learn’ command on the main menu, and will access Compulink
University. 
          • This means that you are no longer limited to accessing Compulink University from the 
main screen of the software only, but may now access it from the Help command anywhere in 
the software.

• Forum/User Group – New option to access the Compulink Advantage Forum.

• On-Line Help – This was previously the only option when clicking the Help command. It 
accesses the On-Line Help manual.

• Product Question:
          • This is a NEW feature that will allow you to send a question to Customer Care.
          • Access to this feature is limited by the following Login Access Right: Support Queue, 
Anomalies & Requests.
          • Select the Department that you would like to send the question to.
          • If you would like to select a specific staff member to send it to, you may, otherwise 
leave the Who field with ‘No Preference’.
          • Enter your question in the large field.
          • Click the Submit command.
          • This will automatically add a call to the Queue for the Department that you selected, 
just as if you had called in to the 800 number.
          • You will receive a call from a representative from that Department, unless you specify 
in the submission that you would prefer E-Mail contact, and include your E-Mail address.

• Request New Feature.
          • This is a NEW feature that will allow you to send a Request for NEW functionality to be 
added to the Advantage software.
          • Access to this feature is limited by the following Login Access Right: Support Queue, 
Anomalies & Requests.
          • Request History grid.
                    • This will display a history of any Requests that have been connected to your 
Compulink account.
                    • Information includes the date it was Added to the Compulink database, the 
Name of your staff member that submitted the Request, the Resolved Date, and the Description
of the Request.
          • To submit a new Request, fill out the following fields:
                    • Where – Where in the software you would like to see the new functionality.
                    • Description – A detailed description of the new functionality that you are 
requesting.
                    • Benefit – How is this new functionality going to benefit your office and possibly 
others?
          • Click the Submit command.
          • Requests for new functionality will be reviewed and responded to within one week of 
the date of submission. In some cases, it will be necessary to obtain more specific information 
before a response can be given and you may be asked to clarify your request further before it 
can be reviewed and documented.
          • NOTE: We receive more than a thousand requests annually for changes to our 
software. These are prioritized by government and industry requirements, followed by clients 
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Help Enhancements
requests which are prioritized based upon the number of clients' and Users associated with a 
specific request. In some cases, requests may be addressed through software customization 
that the client is able to perform on their own or with assistance from one of our Training 
Specialists. If so, you will be advised of this option.

• What’s New:
          • These are new options available.
          • Advantage Product(s) – Opens a browser with a PDF containing the list of 
enhancements for the latest software version. 
          • Compulink University – Opens a browser with a PDF containing the list of new courses 
that are available in the Compulink University LMS. This includes a ‘Take Course Now!’ link that 
will take you to the LMS and register you for the course.

Utility Enhancements
Health Care Maintenance Rules/Orders > Resources > Item

• All Patient Education items with a source of National Eye Institute have been updated with the
new website links. (Client Request)
• The AREDS website was added, with a Category of Macular Degeneration and a Source of 
National Eye Institute.

Health Care Maintenance Rules/Orders > Rules

• Update to Vital Verification Rule. (Client Request) 
• The Rule states that the Height, Weight and Blood Pressure must be entered.
• If the Blood Pressure fields are not filled out, it will no longer trigger the Rule, as long as there
is a reason entered into the ‘BP Reason Not Performed’ field.

Miscellaneous Database Utilities > Optical Utilities > Vuecare UnCheck

• By selecting this Utility, the software will NOT automatically default the VueCare items to ON 
when selecting Order Sets in the patient exam, but your staff may still select them if needed. 
(Client Request)

PracticeWatch Setup > Report Task

• When adding a Report task, the list will now display the name of the Report from the Report 
lists, rather than the actual file name in the Advantage product folder.

Quality Reporting and Meaningful Use > Populate Report Data

• This function has been optimized to run more efficiently when the Attestation box is checked. 
(Client Request)
• The following item will now be included: Objective 9 Secure Messaging. (Client Request)

System Administrator > Login > Profiles

• The following new Login Right was created: Support Queue, Anomalies & Requests.
• If the System Administrator Right is set to Full upon update of the software, this Right will 
default to Full; all others will default to None.
• If set to None, you will not be able to access the following:
          • Compulink menu > Anomaly/Request Status report.
          • Help menu > Product Question.

System Administrator > Login > System Setup

• A new ExpressBill Acct # field was added to the Acct. Billing tab.
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Utility Enhancements
• If a number is entered here, when the Account Statement Function is accessed, it will 
automatically default the check in the ExpressBill box, and will NOT prompt you to enter the 
Acct #.
• If the field is left empty, the first time you run Statements with the ExpressBill box checked, it
will prompt you to enter your Acct #. The software will automatically add the Acct # to the 
System Setup for you, so it will no longer have to be manually entered in the future.

Utility Menu > Utility Menu Deactivation

• The Utility menu will no longer become inactive if the software configuration file was not 
retrieved within the specified time.
• This will allow you to use the System Administrator > Update Configuration utility to update 
your configuration file on your own, and not have to call in to Customer Care. (Client Request)

Customization Enhancements
Modify Database Tables > ALL > Field Name Change

• The number of characters that you can enter for a Field Name has been increased from 8 to 
25.

Screen Builder > Examination > New Gender Field

• A new Gender field was added and can be accessed on User-owned Tabs and Layouts.
• The Gender field on the Layout is available for both Master and Essentials clients.
• The Gender field on the Tab is only available to Master clients, as Essential clients do not have 
the option of customizing individual tabs.
• Options are U (Unisex), F (Female) or M (Male).
• When adding a new Tab and/or Layout in the patient exam, the software will check the gender
of the patient, and only display the Tabs/Layouts that are assigned to that gender or U for 
Unisex.

Smart Function Editor > Exam > New Smart Function Added

• The following new Smart Function was created: SF.DefaultValueAssign([FieldNameArray:array 
of String])
• This allows you to create a Smartscript that will pull the default values to a specific set of 
fields via a button, instead of having to use the full tab default fill with the right-click menu.
• In this example, the field names that you want to pull the default values for are in all caps: 
begin
SF.DefaultValueAssign(['ZZEXTNOSE','ZZNASLMCSA','ZZNOSVALVE','ZZNOBTRCT','ZZTURBINAT'
,'ZZSEPTUM']);
end;
• In the patient exam, click the green circle with the thumbs up, and it will default the fields for 
that section of the screen only.

Look-up Table Enhancements
Compulink Table Updates > Compulink Table Updates

• When downloading Compulink Table Updates, the software will search for and replace only the
Compulink-owned table records that have a modified date that is older than the date on the 
current update file.
• If the record is the same date, meaning that nothing has changed with this Table Update, then
the file will be skipped.
• This is going to greatly speed up the Table Update process.
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Look-up Table Enhancements
• An example of one group of Table Updates is found under Utility > Look-up Tables > Financial 
> Claim Edits/Custom > Compulink Update.

EHR > Assessment/Plan > By Diagnosis Table

• Additional Assessments/Plans were associated with the following Diagnoses: H18.41, H18.42, 
E11.31, G51.0 and H01.

EHR > Body > Location Table

• Upper Lid – Bilateral was added so it may be selected for the Surgical Location. (Client 
Request)

EHR > Custom/Misc. Lookup Tables > Lens OD/OS Tables

• Multiple Subgroups were created for better usability in the exam area.
• Example: In the patient exam, go to the Posterior tab and access the Lens table. Click the 
arrow next to Cataract to display the Subgroup. Click the arrow next to one of the items in that 
Subgroup to display an additional Subgroup.

EHR > Custom/Misc. Lookup Tables > Macula OD/OS Tables

• The following items were added for the Macular exam: Macular hemorrhage absent and 
Macular hemorrhage present.

EHR > HPI > Complaint Table

• Post op LASIK was added to the table.

EHR > Health History > Description Table

• A new entry of Narrow Angle was added, and the SNOMED code was attached. (Client 
Request) 
• The SNOMED code was also added to the entry Anatomical narrow angle glaucoma. (Client 
Request) 
• The Category for Vitreomacular traction syndrome was changed from Personal to Ocular. 
(Client Request)

EHR > Surgery > Name Table

• A new field called ‘Order Set Name’ was added. 
          • You are able to attach an Order Set to a User-owned Surgery in the table. 
          • When the Surgery is selected at the patient Exam, the Order Set that was connected in
the table will run and bring up the individual Orders to select from.

EHR > Surgery > Name Table

• The following Surgeries were added to the table: (Client Request)
          • Cataract surgery w/ Multifocal IOL
          • Cataract surgery w/ Toric IOL
          • Mastectomy

EHR > Test > Name Table

• The following Tests were added to the table: Electroretinography (EPG), InflammaDry, OCT 
Anterior – Both Eyes, OCT Macula – Both Eyes, OCT ONH – Both Eyes and Visual Evoked 
Potential (VEP). (Client Request)

EHR > Visual Acuity Table

Compulink Business Systems, Inc | 1100 Business Center Circle | Thousand Oaks, CA 91320 | 800.888.8075 .
support@compulinkadvantage.com | www.compulinkadvantage.com           9



Look-up Table Enhancements

• The following Subgroups were added to easily note + or - entries on a Visual Acuity line using 
the new Dual Topic Tree Data Entry efficiency:
          • Numbers: 1, 2, 3, 4
          • Plus or Minus: +, -
• When accessing the table from the patient exam, click the arrow next to the value to display 
the +/- Subgroup, then click the arrow next to the +/- to display the Number Subgroup.

Financial > Claim Edits/Custom > Compulink Update

• The latest Claim Edit/Payor Set from 8/31/16 is included with this version update.
• You may also download the latest Advantage Claim Edits/Payors Guide by clicking the link 
below and logging in with Username: Partner and Password: 4success
http://client.compulinkadvantage.com/payor-claim-edit/

Financial > Services Table

• Visual Evoked Potential (VEP) (95930) was added to the IMAGING section. (Client Request) 
• InflammaDry (83516) was added to the LACRIMAL DRAINAGE SYSTEM section. Modifier of QW
was added to the Medicare fee column. (Client Request)

General > Departments Table

• The Description field has been increased to 50 characters.

General > Provider Table

• A new Registry field was added to facilitate Registry reporting for CMS.
• Initially it will only be used by Eyecare Advantage software users with the AOA More interface.

General > Todo/Followup > By CPT Code Table

• You now have the option of assigning Surgical codes to a ToDo Action Group. 
          • When a Surgery is posted to the patient exam, if the CPT Code is found in this table, 
the corresponding Group of ToDo Action items will be assigned to the patient account.

General > Todo/Followup > Groups Table

• You now have the option to Hide the Detail Action items attached to the Compulink-owned 
Groups.

General > Todo/Followup > Items Table

• The Dept field is no longer blocked on Compulink-owned items. 
          • This allows you to edit the Compulink-owned item instead of having to duplicate it to 
create a User-owned item to add a Department.

Spectacle > Lens > Components (Multiple Tables)

• Optifacts Mapping IDs were added to multiple items. (Client Request)

Spectacle > Lens > Components > Coating / Add-On Table

• New items added to the table:
           • AR-DEL Claris blu Defense
           • AR-DEL Claris HD SuperHydro
           • AR-DEL HD Plus 
           • AR-Kodak Total Blue
           • AR-Xperio UV
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Look-up Table Enhancements

• V Codes (Ins. Code) updated on the following items:
           • Mirror-NXT Gold
           • SRC-TD2 w/Optifog
           • Wiley X Anti-Fog

• VSP Codes were added to the following focal types:
           • AR-Duravision items

Spectacle > Lens > Components > Focal Type Table

• New items added to the table:
          • Zeiss Digital items

• Updates made to existing items:
          • SV Autograph II – BLURBGROUPBRAND of Single Vision added
          • SV Autograph II Attitude – BLURBGROUPBRAND of Single Vision added

Spectacle > Lens > Components > Lens Property (Transition/Polaroid)Table

• New items added to the table:
          • Polarized Kodak Total Blue
          • Polarized Xperio

Spectacle > Lens > Components > Tint Table

• New items added to the table:
          • Glass Brown 1, 2 & 3
          • Glass Gray 1, 2 & 3
          • Oakley (additional colors)
          • Oakley Tint Prism

• VSP Cost Codes were added to the following items:
          • Essilor tints

Spectacle > Lens > Definitions Table

• New items added to the table:
          • 8 x 35 Trifocal lenses
          • Aquity HD lenses
          • Augen Trinity
          • BF FT-28 1.55/1.56 Transitions 7 Brown and Gray
          • BF FT-35 Trivex Transitions 7 Gray
          • BF Sector Round 22
          • Bravo Classic
          • Brillenz
          • Choice Poly Transition lenses (Brown and Gray)
          • Comfort 2 DRx Transition Lenses (XTRActive Brown added)
          • Compact Ultra PhotoFusion lenses in Gray
          • Crossbows Single Vision and Progressive
          • Curve PAL
          • DriveSafe Individual lenses
          • Epic Office lenses
          • Everyday Transition lenses
          • FreeFocus lenses
          • FreeFocus PC20 lenses
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Look-up Table Enhancements
          • G-PAL
          • HAPPY Progressive Polarized
          • Ideal Advanced Transition Lenses (XTRActive Brown added)
          • Intellego III lenses
          • Kodak DSII lenses, Kodak SoftWear lenses
          • MauiPassport PR Polycarbonate Polarized HT Green
          • MOD Pal
          • Natural DS Transition Lenses (XTRActive Brown added)
          • OUTDOOR Pal
          • Ovation DS Transition Lenses (XTRActive Brown added)
          • Perceive HD lenses, Perceive Short HD lenses, Perceive Wrap HD lenses
          • Physio Airwear Polarized Brown 3 and Gray 3
          • Physio DRx Transition Lenses (XTRActive Brown added)
          • Physio DRx Thin & Lite 1.67 Transitions XTRActive
          • Physio DRx Thin & Lite 1.74 Aspheric
          • Physio Enhanced Trivex Transitions 7 Brown
          • Physio W3+ 1.50 Index Polarized Essilor Brown and Gray
          • Physio W3+ 1.50 Xperio UV Brown and Gray
          • Physio W3+ Airwear Polarized Brown 3 and Gray
          • REVO Progressive and Single Vision
          • S Design 1.50 XTRActive Brown and Gray
          • S Design Airwear XTRActive Brown and Gray
          • S Design Short 1.50 XTRActive Brown and Gray
          • S Design Short Airwear XTRActive Brown and Gray
          • S Design Thin&Lite 1.67 Transitions XTRActive Brown and Gray
          • S Fit 1.50 Transitions XTRActive Brown and Gray
          • S Fit Airwear Transitions XTRActive Brown and Gray
          • S Fit Thin&Lite 1.67 Transitions XTRActive Brown and Gray
          • Seiko Supernal lenses
          • ShoreView Digital lenses
          • SV 1.74 Ultra High-Index Aspheric Transitions 7 Brown and Gray
          • SV CURVE
          • SV EyeZen + (1,2 and 3) lenses
          • SV Shamir lenses
          • SV Synchrony HDC
          • SV Zeiss Digital 1250 lenses
          • Synchrony Access HD 75, 125 and 175
          • Synchrony Easy Adapt HD
          • Synchrony Easy M HD
          • Synchrony Easy S HD
          • Synchrony EasyView HD
          • Synchrony EasyWear HD
          • Synchrony Performance HD
          • Synchrony Starter HD
          • Synchrony Ultra HD
          • Synchrony Ultra HDC
          • Synchrony Ultra HDV
          • Synchrony Work & Go HD
          • Synchrony Work & Office HD
          • Synchrony Work & Read HD
          • Unity PLx Mobile lenses (and other Unity lenses)
          • Universal Transition Lenses
          • Visionary lenses (added Transitions 7 Brown, Gray and Graphite Green)
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Look-up Table Enhancements
• New Lens Components added:
          • Polarized PR Brown 3 was added to the Summit ecp Poly Polarized Brown 3 lens
          • Varilux Physio W3+ added to all Physio W3+ lenses
          • Epic Office lenses have updated Components

• Updates to existing lenses:
          • Min and Max Power added to SV hybrid lenses

• VSP Cost Codes were added to the following lenses:
          • Amplitude Phoenix Polarized Brown 3 and Gray 3
          • Amplitude Phoenix Transitions 7 Brown and Gray
          • Amplitude Phoenix Transitions XTRActive
          • Amplitude Phoenix Vantage Transitions
          • Amplitude Poly Polarized Brown 3 and Gray 3
          • Amplitude Poly Transitions 7 Brown and Gray
          • Amplitude Poly Transitions XTRActive
          • Amplitude Poly Vantage Transitions
          • Autograph III (Fixed 15mm) SuperLite 1.74 Transitions 7 Brown and Gray
          • Definity Short Thin&lite 1.67 Transitions 7 Gray
          • Everyday Transition Lenses
          • Hoya Amplitude BKS Poly Transitions Gray
          • Hoya Tact 40 BKS 1.56 BluTech Indoor
          • Hoya Tact 60 BKS 1.56 BluTech Indoor
          • Physio Enhanced Trivex Transitions 7 Brown
          • Summit ecp Poly Polarized Brown 3
          • SV 1.74 High Index Aspheric lenses (VSP Lens Style Code updated as well)
          • SV 1.74 Ultra High-Index Aspheric Transitions 7 Brown and Gray
          • SV 3D lenses
          • SV Essilor lenses
          • SV EyeZen lenses
          • SV Relax 16 lenses
          • Unity PLxpression 18 Poly Transitions 7 Brown
          • Unity PLxtra Mobile 20
          • Universal Transition lenses

• VSP Lens Style Codes were added to the following Lenses:
          • Unity PLxtra Mobile 20

Spectacle > Optical Lab > List Table

• New labs added to the table:
          • VSPOne Los Angeles

• Updates to existing labs:
          • B & D Optical
          • Carl Zeiss Vision SiouxLand
          • Omega Optical Company - Dallas
          • Opti-Craft
          • Team Effort Optical
          • VSP labs (all)
          • VSP Lab Dallas

Spectacle > Plan > Benefit Formulas Table

• New items added to the table:
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Look-up Table Enhancements
          • Medicaid AL V2744 Photochromic If Covered INS

• Updates to existing items:
          • Davis Progressive Copay – Ins – Formula updated 
          • Davis Progressive Copay – Pat – Formula updated

Spectacle > Plan > Benefit Options Table

• Updates to existing items:
          • Medicaid V2784 WY – Allowed amount updated.

Spectacle > Plan > Definitions Table

• New Plans added to the table:
          • Davis Vision ACMC Purchsing Group Plan XWP
          • Davis Vision A.T. Stills Plan YCT
          • Davis Vision Embrace Home Loans
          • Davis Vision FEP Blue Vision
          • Davis Vision Kansas City Life
          • Davis Vision LHC Group, Inc Plan LHC
          • Davis Vision Maschhoff Family Foods Plan YCE
          • Davis Vision Pinnacle Entertainment Plan XAX
          • Davis Vision PPG Industries Plan PGG
          • Davis Vision Trinity Industries Plan TRI
          • Davis Vision UAW Retiree Med Ben Trust Plan RMB
          • Superior Vision Plan MO
          • VSP Medicaid Louisiana

• Updates to existing Plans:
          • VCP Primary Plus Plan – VCP Primary Plus Photochromics Benefit Option added
          • VCP Primary Plus Private Plan - VCP Primary Plus Photochromics Private Lab Benefit 
Option added

Patient Area Enhancements
Appointment History Grid > New Tool Icon Added

• A new Tool icon was added to the header of the Appointment History grid. (Client Request)
• Clicking this icon will open a window displaying the Next Appointment Recommendations that 
the Provider entered in the Examination area.
• Staff can use this information when trying to schedule the next Appointment with the patient.

Utility Command > New Utility Command Created with Menu Items

• A new Utility command was added with the following options:

• ERx Patient Connect.
          • Part of AdvantageERx (NOT NewCrop), this utility shows all Refill Requests that came 
in, and were unable to be attached directly to a patient.
          • For more detailed information on the NEW AdvantageERx ePrescribing interface, please
see the Compulink University LMS program AdvantageERx for a list of related courses.

• CCD Patient Connect.
          • This was previously found on the main screen under Function > Connect Unattached 
CCDs to Patient.
          • See the Help file for detailed information.
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Patient Area Enhancements

• Patient Portal Setup w/o E-Mail.
          • This Utility allows you to create a Patient Portal account for patients that do NOT have 
an E-Mail address.
          • A Patient Portal window opens with the following fields:
                    • User Name – This is automatically generated by the software.
                    • New Password – Enter a temporary password for the patient that they will be 
allowed to change on the Portal.
                    • Confirm Password – Enter that same temporary password.
                    • Secret Question – Select a Secret Security Question.
                    • Answer – Enter the Answer to the Secret Question.
                    • Click the Save Changes button.
          • A Print window will open with the option for you to print a confirmation with the web 
address for the Portal and the User Name. Click OK to print, or Cancel to skip printing.
          • This will bypass the E-Mail validation step, and the patient will go directly to 
www.MySecureHealthData.com and enter the User Name and Password that was established in 
the office.
          • In the patient exam, when you click MU > Send CCD to Patient Portal, it will no longer 
require the patient E-Mail field to be filled out.
          • NOTE: In order to send to the Portal, you MUST either have a patient E-Mail address 
OR have set up an account using Utility > Patient Portal Setup w/o E-Mail.
          • The Function > Portal Communication will also send information to these Portal 
accounts established using the Utility.

Web Registration > Social Security Number

• You now have the option of entering X’s for the first 2 sections, and then entering just the last
4 digits. (Client Request)
• This feature is by request, so contact the Customer Care department to request the change.

Worklist > Worklist Enhancements

• A new image was added for the Refresh command.
• A new Print option was added to print the Worklist. (Client Request)

Appointment Enhancements
Column Command > Loading Another User’s Configuration

• You now have the option to Load Another User’s Configuration for viewing, or to use as a 
starting template to create a New Configuration. (Client Request)
• Click Column > Customize.
• When the window opens, click Save, Delete or Load.
• Select ‘Load Another User’s Configuration’ and it will display a list in the window below.
• Highlight a Configuration and click Save, or double click to select.
• This will load the Configuration for you to view and/or make changes to and Save as a New 
Configuration.

Enhanced Appointment Scheduler > Enhanced Scheduler is Default

• The Enhanced Appointment Scheduler is now set as the default.
• To access the Legacy Scheduler, from the main screen or the patient demographic screen, 
right click on the bottom of the window and select ‘Turn Enhanced Appt Scheduler On/Off.’
• You will receive the following message: Legacy Scheduler will be discontinued 9/30/16 to 
allow future Scheduling enhancements to continue!

Normal View > Opening Multiple Windows
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Appointment Enhancements

• You now have the ability to open multiple windows in the Enhanced Appointment Scheduler. 
(Client Request) 
• Click the Appt Command to open up to a Daily Detail view.
• Move that to the side and click the Appt Command again to open another Daily Detail view.
• Once open, you can change the views to Week at a Glance or Office at a Glance, or leave as 
Daily Detail.
• You may also change the Day, Location and/or Provider per window.

Print Command > Week at a Glance Report

• The Week at a Glance report now prints based on the week of the resource you have 
highlighted, not just the current week.

View Command > Loading Another User’s Configuration

• You now have the option to Load Another User’s Configuration for viewing, or to use as a 
starting template to create a New Configuration. (Client Request)
• Click View > Save, Load or Delete.
• Select ‘Load Another User’s Configuration’ and it will display a list in the window below.
• Highlight a Configuration and click Save, or double click to select.
• This will load the Configuration for you to view and/or make changes to and Save as a New 
Configuration.

View Command > Retaining Your Specified Default View

• After accessing the Appointment Scheduler for the first time and selecting your preferred 
view, once you exit out and re-enter, it will now retain that specified view, and no longer revert 
back to the Normal view. (Client Request)
• This means that you may select the Normal View, Office at a Glance, or even a Custom View 
as your Default view.
• This is based upon your specific Login ID, and will remain the same (even after exiting and re-
entering the software) until you select a different view and exit the Appointment Scheduler in 
that view.

Examination Enhancements
AdvantageERx > ePrescribing interface

• AdvantageERx is Compulink’s new direct ePrescribing interface with Surescripts and First 
Databank. 
• Currently in the BETA STAGE, and only available by request, Advantage NewCrop users will be
assisted with migration over to AdvantageERx.
• Please note that once this migration is completed, you will NOT be able to prescribe through 
the NewCrop interface.
• For more detailed information on this functionality, please see the Compulink University LMS 
program AdvantageERx for a list of related courses.

General > Dual Tree View

• The Dual Tree View will bring up the tables for both the right and left side at the same time in 
order for you to document more quickly.
• You will see this feature in fields that are in the main exam and end with an OD or OS (for 
ophthalmic) or R or L.
• Double click (memo field) or open with the drop-down arrow and it will bring up both tables to
select from.
• The field names are displayed across the top of the PopUp window.
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Examination Enhancements
• The blue arrows in the middle allow you to transfer your choices from one side to the other.
• Single click to check an item and move on to check others, or double click to choose an item 
and close the table.

General > Tables with Subgroups

• When accessing tables that you have created Subgroups for, the header will appear in the list 
with a triangle to the left.
• Click the header and the list will expand to display all of the items that were attached to the 
Subgroup.

Layouts > New Layouts Added

• The following are for Eyecare and Ophthalmology Advantage.
• Cataract Pre-Op (HiRes).
          • Allows providers and staff to use more efficient HiRes layouts.
          • On the Pre-Op tab, you can see the Testing information, rather than having to go to a 
separate tab to see items like the IOL’s.
          • The ExamCataractPreOp document will print when selecting the ‘Complete’ document, 
and the ExamPositive2Column will print when selecting the ‘Positive’ document.

• CL Check (HiRes).
          • This is a one tab solution for a quick Contact Lens ReCheck with the patient (it is 
equivalent to the old CL Check layout).

• Lasik Pre Op (HiRes). 
          • This layout contains the following tabs: Lasik Pre Op (HiRes) and History (HiRes).

• Rx Recheck (HiRes).
          • It is made up of just the new Rx Recheck tab, and provides one tab for entering all of 
the pertinent information. (Client Request) 

• Vision Exam (HiRes).
          • Created new layout with Refraction/CL (HiRes) tab.
          • This may be used for Vision Exams with more detail on the Refraction/CL tab.

Open Office Documents > Enhancement Made to Existing Compulink-Owned 
Documents

• The following are for Eyecare and Ophthalmology Advantage.
• Updates were made to several documents for the following items:
          • Medications - Units were combined with Strength to support new use of field.
          • Null refraction type will now print.
          • Visual Acuities layout updated.
          • Letterhead will print the ADD Location when users are on a CBSWAN, rather than the 
patient demographic Location.
          • Reordered the Iris, Color, Lens, Clarity, Anterior Cap, Posterior Cap, Cortex and Nucleus
and moved them from the Posterior Exam to the end of the Anterior Exam.
          • ExamOperativeReport/Sign – Added Description to the Pre-Op and Post-Op Diagnoses.
          • CLRx – Added Acct number and rearranged the fields in the header.
          • ExamLabAllOrders/Sign and ExamLabOnlyOrder/Sign – Added Diag 2 and Diag 3.

• Updates were made to the ExamLASIKPostOp and ExamLASIKPreOp documents for the 
following items:
          • Visual Acuities were added.
          • Intraocular Pressures were added.
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Examination Enhancements
Open Office Documents > Enhancements Made to Existing Compulink-Owned 
Documents

• The following are for ALL Advantage products.
• Updates were made to several documents for the following items:
          • Letterhead will print the ADD Location when users are on a CBSWAN, rather than the 
patient demographic Location.
          • Medication – Added Units to Strength to support new use of field.
          • ExamLabAllOrders/Sign and ExamLabOnlyOrders/Sign – Updated to include Diag 2 and 
3.

Open Office Documents > Enhancements Made to Existing Compulink-Owned 
Documents

• The following are for Eyecare Advantage ONLY.
• Updates were made to several documents for the following items:
          • New ExamImagesAll will print ALL EHR Documents for legal purposes if needed.
          • Added ‘Patient refused dilation’.
          • Added Eye OU.

Open Office Documents > New Documents Added

• The following are for Eyecare and Ophthalmology Advantage.
• The following new Open Office documents were added: 
          • ExamCompleteNeuro
          • ExamPositiveLowVision2Column
          • ExamPositiveVisionTherapy2Column
          • ExamReferralSummarySign
          • PedsTraumBrainInjuryQuestionnaireForm

Print Command > Print > CCD Document

• This document will now include the patient cell phone number. (Client Request)

Print Command > Print > Range

• In previous versions, when selecting Print > Range, the software would process and display 
one document per exam date. If there were 4 exams, it would bring up 4 individual documents.
• Now the software will still process every exam date, but it will merge them all into one 
document.
• These will be the complete document per exam, but just merged into one so it will make it 
easier to make changes and save or print. (Client Request)

Tabs > Enhancement Made to Existing Compulink-Owned Tab

• The following is for Eyecare Advantage.
• Lasik Pre Op (HiRes).
          • The Dilated information was added to the header at the top. When you click in the 
Dilated box, the Smart Function will automatically assign the Eye (OU), the Drops, and the 
Time.

Tabs > Enhancements Made to Existing Compulink-Owned Tabs

• The following are for ALL Advantage products.
• Medications.
          • Pharmacy Name field.
                    • In preparation for the NEW AdvantageERx, the Pharmacy Name field has been 
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Examination Enhancements
replaced with just a Pharmacy field.
                    • This field was updated in the database to the name PharmUnique, and is now a 
table look-up field.
                    • You will no longer be able to free-type in the field, you must select from the 
table.
                    • You will select the Pharmacy from the table drop down as normal, but the field 
will store the unique number attached to the Pharmacy in the table.
                    • Upon update, the software will match your existing Pharmacy name in the 
patient record to the Pharmacy listed in the table and pull the unique number into the database 
for you.
                    • If a match is not found in the table, a user-owned entry will be created for you.
                    • If you have created custom Open Office documents with the Pharmacy Name 
field, you do NOT need to make any changes to them.
          • Medical Needs field.
                    • If the Provider fills in the Medical Needs field, it will now print on the 
prescription with a 'Medically Necessary: ' notice right above the Prescriber signature area.

• ROS (Review of Systems).
          • A new memo field called ‘Notes’ was added to the PopUp for the SMBS/HgbA1c. 
                    • The ‘Value’ field for reporting BS/HgbA1c is strictly a numerical field.
                    • If a patient reports ‘Normal’ as their BS/HgbA1c result, you may now enter that 
into the ‘Notes’ field for tracking. (Client Request)
          • Vitals grid.
                    • A new BMI Tool button was added to the header on the Vitals grid.
                    • After pulling in the patient data from Web Registration, click the BMI Tool button
to calculate the BMI based on the imported height and weight data.
                    • This was also added to other tabs that contain the Vitals information. (Client 
Request)

Tabs > Enhancements Made to Existing Compulink-Owned Tabs

• The following are for Eyecare and Ophthalmology Advantage.
• CL Diag.
          • A new Wear Type field was added for documenting Current, Final, etc. 1951045
                    • The field is similar to the one used for the Refraction.
                    • The Type column was also added to the grid.
                    • This change was also made to the following tabs: CL Diag (Style 2), CL Eval, CL 
(Tablet) and Refraction/CL (HiRes).
          • The Contact Lens PopUp now has ‘1 Year’ and ‘2 Year’ buttons for adding the Expires 
Date. (Client Request) 
                    • You may still select a date from the drop-down, or click a button to 
automatically fill the field. 
          • There are 2 new Tool icons that will pull in the Visual Acuities that were entered into 
the exam. (Client Request)
                    • The Near VA will pull the 'with correction' fields.
                    • The Distance VA will pull the 'with correction' fields.

• Codes.
          • Code 6880 was removed, as it is no longer a valid code. (Client Request) 

• Exam (HiRes).
          • The field ’Office Code to Bill’ was added to the Diagnosis section. By selecting a code, it
will allow you to override the coding recommendations suggested by the software.
          • Tests grid.
                    • This grid was updated so it will now display ALL Tests, and not just the Tests 
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that have been Reviewed. (Client Request) 
                    • A button was added to the Tests header that will add the Testing (HiRes) tab on 
the fly. This button was also added to the Testing Summary (HiRes) tab. (Client Request) 
          • Work-Up Hover History.
                    • The top header now has the caption ‘Work-Up’ in bold letters.
                    • Hover over the caption and a Hover History window will open with the following 
information: Exam Date, Complaint, DVA SC OD/OS, DVA CC OD/OS, IOP for OD/OS and 
Dilation (checked for yes).
                    • This window allows the Provider to view the patient’s information without having
to click back to the WorkUp tab.

• History (HiRes).
          • A Multi-Add Grid Edit was added.
                    • When clicked, it will go through the Grid Edits for all of the following sections: 
Ocular History, Personal Medical History, Family History, Social History and Tobacco Use.
                    • Once each page is saved, the data will populate the appropriate grid on the tab. 
(Client Request) 
          • A new ‘Breast Feeding’ checkbox field was added. 
                    • This field will be used for screening medications in AdvantageERx.
                    • This field was also added to the ROS (Review of Systems) tab. 
          • Surgical History grid.
                    • Now displays ALL Surgeries, and not just Optical. 
                    • Any tab that contains the Surgical History will now default with the Historical 
field checked when adding a record. This will NOT default on current Surgical areas on the 
Procedure and Treatment tabs. (Client Request) 
          • Vitals grid was added. (Client Request) 
                    • The items that were buttons on the Vitals tab were added as icons to the header
of the Vitals grid.
                    • Icons are for the following: Calculate BMI, Growth Chart, Physical Activity, 
Nutrition and Vitals History.
          • Allergies grid.
                    • Tool button was added that when clicked will add a record of NKDA (No Known 
Drug Allergies). (Client Request)

• Images.
          • The Exam Date was added to the top right of the tab.
          • When adding an Image record, you now have access to change the Date field (the Date
the item was added into the exam record).

• LVHx (Low Vision History) - Visual Concerns section.
          • The ADL’s field was changed to a Memo field.
          • You may now double click in the Vocational Issues field to access a table. 
                    • Compulink is in the process of getting suggestions for table entries.
                    • To add User-owned entries, right click in the field and select ‘View Lookup List 
Entries’.
                    • This will open the table and you may add your entries and then Exit out.
                    • When you double click in the field, the PopUp will now open for you to select 
from your User-owned entries. 

• Objective.
          • IOP PopUp.
                    • Fields were added for Corneal Hysteresis and WF Score; these will be used for 
an equipment interface.
                    • The Encounter Favorite star was added to enable clients to quickly select 
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Encounter Favorites that they create for IOP data entry. (Client Request)

• Plan.
          • Diagnosis PopUp – The Assessment and Plan fields were made bigger to display 6-7 
lines. (Client Request) 
          • Next Appointments.
                    • You can now double click on an entry in the grid to open it in edit mode.
                    • Change was made to all tabs with the Next Appointments grid. (Client Request) 

• Refraction.
          • Make Available for Optical.
                    • If the patient lives in the state of Ohio, when this field is checked, it will put an 
expiration date 2 years out.
                    • The same will happen for the following states: California, New Hampshire, 
Massachusetts and Texas.
                    • All other states will default to 1 year. (Client Request) 
          • Expiration buttons.
                    • The Diagnosis that is added to the patient record when using either the '1 Year' 
or '2 Year' expiration button, will now default to the ICD-10 Diagnosis, and include the 
Assessment and Plan.
          • There are 2 new Tool icons that will pull in the Visual Acuities that were entered into 
the exam. (Client Request)
                    • The Near VA will pull the 'with correction' fields.
                    • The Distance VA will pull the 'with correction' fields.

• Refraction/CL (HiRes).
          • The VA will now display in the historical grids.

• Retina Summary (HiRes).
          • The Tests grid will no longer display the SMBS/HgbA1c as if it was done in the office, if 
it was marked 'Patient Reported' when entered by staff. (Client Request)
          • This change was also made to the following tabs: Glaucoma Summary, Glaucoma 
Summary (Style 2), Posterior (Style 2), Bio Microscopy, Anterior, Summary, Lasik Pre Op 
(HiRes), Summary (HiRes) and Exam (HiRes).

• ROS (Review of Systems).
          • SMBS/HgbA1c grid – The new Notes field was added to the grid. If the staff 
documented ‘Unknown’ as the patient response in the Notes field, it will display in the grid. 
(Client Request) 

• Summary (HiRes).
          • Tests Not Reviewed grid was changed to Tests grid, and will now display ALL Tests, and 
not just the ones that were not reviewed. (Client Request)

• Tech Work Up (HiRes).
          • Test Not Performed grid will no longer display items that were marked as ‘Patient 
Reported’ (example: Blood Sugar). (Client Request) 
          • The IOP grid will now display the Notes field. (Client Request)

Tabs > New Tabs Added

• The following are for Eyecare Advantage ONLY.
• Cataract Pre-Op (HiRes).
          • Allows the user to see Testing information and ALL Cataract Pre-Op information on one 
screen.
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Tabs > New Tabs Added

• The following are for Eyecare and Ophthalmology Advantage.
• CL Check (HiRes).
          • This is a one tab solution for a quick Contact Lens ReCheck with the patient (it is 
equivalent to the old CL Check layout).

• Lasik Post Op (HiRes).
          • This new tab combines the Lasik Post Op lower resolution screens into one tab.

• Refraction/CL (HiRes) – Created for those who do more CL fittings, and need to be able to 
capture all Refraction and Contact Lens information on one screen.

• Rx Recheck (HiRes).
          • Provides one tab for entering all of the pertinent information.
          • Contains the following: Complaint History, Visual Acuities, Objective Notes, 
Refraction/Visual Analysis, Spectacle Spending History, Diagnosis and Next Appointment.
          • This tab also makes up the new Rx Recheck layout that was created.

• Summary 2 (HiRes).
          • This tab was created for offices that do not do Optical. The Spectacle and Contact Lens 
Spending History was removed. (Client Request)
          • For clients using lower resolution screens, there is already a Summary (Style 2) tab 
that does not include this information.

Utility Command > C.L. Availability

• This NEW option will use the findings (Sphere, Cyl, Base Curve, Diameter, etc.) from the 
HIGHLIGHTED exam Contact Lens record to search the ABB Concise database and display a list 
of available lenses.
• Highlight the Contact Lens record, click the Utility command and select C.L. Availability.
• Enter either R or L to indicate laterality to search by and click OK.
• A window will open with a list of available lenses to view only.
• This feature is similar to the one that is available in the PopUp.

Utility Command > Tab Remove Option Added

• This option will allow the user to remove the last tab (furthest to the right) on the layout, as 
long as it was added ‘on the fly’ and not part of the original layout.
• The user that is logged in must have edit rights in the exam in order for this option to be 
available.

Spectacle Rx Enhancements
Fees Window > Analysis Command

• The Analysis command was added to allow the staff to compare jobs for profit consideration.
• Click the button and it will open the Crystal report called Spectacle Quote Analysis.
          • Items from the Fees screen are listed with their Retail and Cost, as well as Expected 
Amounts from insurance and the patient.
          • Frame Cost – If ‘frame’ is in the item description in your Fees screen, that Cost counts 
toward the Total Cost.
          • Lab Cost – This is pulled from the Cost entered on the Spectacle Rx Lab Info tab. It 
counts toward the Total Cost.
          • Component Cost – If Lab Cost is greater than zero, it is assumed to be a package Cost 
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Spectacle Rx Enhancements
for ALL lens components. Individual component Cost is grayed and wont count toward the Total 
Cost. If Lab Cost is blank or zero, each individual lens component Cost counts toward the Total 
Cost.
          • Profit.
                    • Net Profit is the Retail minus Total Cost.
                    • Expected Profit is the Net Profit minus Adjustments.

General > VSP Eyefinity Interface Reminder

• If you are not currently utilizing the VSP Eyefinity Interface, a weekly reminder will pop up 
upon saving of the Spectacle Rx screen.
• This will only pop up for patients that have some form of VSP in the Plan field.
• Contact Customer Care for further information about the Eyefinity Interface.

Lab Info Tab > User Owned Lab Pricing

• The Lab Info tab now has a section called ‘User Owned Lab Pricing.’
• Users may calculate projected profit before posting the job.
• The blue Info button will bring up a window with information about what you must do for the 
buttons to work.
• You have the option of creating and attaching PDF files for 6 different labs.
• PDF files must be stored in the Advantage product folder (Eyecare or Eyemd) with the names:
Lab1.pdf, Lab2.pdf, Lab3.pdf, Lab4.pdf, Lab5.pdf and Lab6.pdf.
• Click a button to bring up the associated PDF file.
• Use the information on the PDF file to enter the total package Cost for the job on the Lab Info 
tab. This will display on the Spectacle Quote Analysis Report.

Spec Order Tab > VSP Eyefinity Interface Fields

• The following frame fields will now be submitted using the Eyefinity interface: B, ED and DBL.

Ledger Enhancements
Collection Module > Update to the Collection Module

• If an Adjustment is made to the Ledger, and the patient balance is brought to zero, the 
<COLLECTION> flag will remain at the top of the Ledger, and the Collection record will remain 
open. (Client Request)
• These Collection records will no longer automatically close, but will stay open and allow you to
continue to work them until you are ready to close them.
• Once you are finished with the Collection and/or the Agency, YOU must close the Collection 
record, and then the <COLLECTION> flag will be removed.

Delete Command > Deleting Charges After Payments are Posted

• A charge is posted to the Ledger and a payment is applied using Line Item Posting.
• For some reason, the charge needs to be deleted.
• You no longer have to click on Options > Delete Line Item Pmt Dist.
• If you delete the charge, the software will automatically correct the payment history and 
move the money into the Unapplied for you.
• ***Compulink does not suggest using the Delete option on charges. You should use either the
Void or Return, so there is a history on the ledger. The Delete option should only be used for 
special circumstances that are established by your practice administrator.

Statement > New Ledger Statement History report

• This report matches the view of Receipt and Statement History that is seen under Options > 
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Ledger Enhancements
Statement History.
• Receipts and Statements to this account are included if printed as follows:
          • Individual Ledger Receipt or Statement (Ledger > Print > Receipt or Ledger > Print > 
Statement).
          • Batch Account Statements (Function > Patient Statements).
          • If a Receipt or Statement was printed from the Ledger > Print > Report menu, it will 
NOT be included in this report.
• From the patient Ledger, click on Print > Report and select Ledger_Statement_History.
          • Enter a Start Date and End Date; they both will default to the current date.
          • Click Begin.
          • Detailed data includes the following: Billed Date, Output (Receipt or Statement), 
Provider, Location and Total Amount.
          • Report Total Counts includes the following: All (number of Receipts and Statements 
printed), number of Statements printed and number of Receipts printed.

Interface Enhancements
Contact Lens > ABB Concise

• Compulink offers an interface for Contact Lenses with ABB Concise.
• The ABB Concise Contact Lens catalog is included with Version 11.0.6.1 and greater, and can 
be used for the following:
          • Building your Contact Lens inventory; similar to using Frames Data for frames.
          • Completing the Contact Lens Rx screen.
• The interface for Placing Orders to ABB Concise through the Advantage software is available in
Version 11.0.7.0 and greater.
• NOTE: If there is no ABB Concise Acct # entered into setup, you will receive a suggestion to 
utilize the interface. This will pop up once per week upon saving the Contact Lens Rx screen.
• Please see the following Compulink University LMS course for detailed information: ABB 
Concise For Contact Lenses.

New Features & Enhancements for Previous Version Builds:

11.0.6.4 (2/10/2016)

11.0.6.3 (11/07/2015)

11.0.6.2 (11/07/2015)

11.0.6.1 (10/07/2015)

11.0.6.0 (09/03/2015)

11.0.5.6 (08/10/2015)

11.0.5.5 (07/31/2015)

11.0.5.4 (07/02/2015)

11.0.5.3 General Updates (06/24/2015)

11.0.5.3 EHR Updates (06/24/2015)

11.0.5.2 (05/11/2015)

11.0.5.1 (04/15/2015)

11.0.5.0 (03/23/2015)

11 (< 11.0.5.0)
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http://client.compulinkadvantage.com/wp-content/uploads/WhatsNew11_O.pdf
http://client.compulinkadvantage.com/wp-content/uploads/WhatsNew_11050_O.pdf
http://lms.compulink-software.com/lms/pdf/WhatsNew_11051_O.pdf
http://lms.compulink-software.com/lms/pdf/WhatsNew_v11052_eye.pdf
http://lms.compulink-software.com/lms/pdf/EHRUpdates_11053_O.pdf
http://lms.compulink-software.com/lms/pdf/WhatsNew_11053_O.pdf
http://lms.compulink-software.com/lms/pdf/WhatsNew_11054.pdf
http://lms.compulink-software.com/lms/materials/WhatsNew_11055_O.pdf
http://lms.compulink-software.com/lms/materials/WhatsNew_11056_O.pdf
http://lms.compulink-software.com/lms/materials/WhatsNew_11060_O.pdf
http://lms.compulink-software.com/lms/materials/WhatsNew_11061_O.pdf
http://lms.compulink-software.com/lms/materials/WhatsNew_11062_O.pdf
http://lms.compulink-software.com/lms/materials/WhatsNew_11063_O.pdf
http://lms.compulink-software.com/lms/materials/WhatsNew_11064_O.pdf

